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Overview
___________________________________________________________

SLIM SHOW 1.0 lets you create and play professional looking, interactive multimedia 
presentations within Microsoft Windows.      It provides an easy to use, drag-and-place 
authoring environment for integrating multimedia materials consisting of text, WAVE sound, 
MIDI music, bitmap graphics, synthesized speech (text-to-speech) and buttons.
    
Once a project is built and tested, you can either run it directly within SLIM SHOW 1.0 or 
distribute it with a standalone player(the multimedia engine).      The player is very compact, 
requiring less than 50K bytes of diskette space for non text-to-speech projects or 550K bytes
for projects with text-to-speech.    The player will expand and run your project on target PCs 
automatically and then remove all components when the show is finished.    You can also 
choose to build your projects using manual mode.    The manual mode builder will generate 
an executable player program with all supporting library files.    It will collect all of the show 
material files and put everything into a single subdirectory.      This mode is useful for 
developers who wish to integrate multimedia projects within their own programs.

SLIM SHOW 1.0 does not come with tools to create the material files (bitmap, MIDI, WAVE or 
text).    Since these are all standard Windows files, you can find most of the basic editing 
tools for them on your Windows system - Paintbrush for bitmaps and Notepad for text.    The 
WAVE recorder is usually supplied with your sound card.

The system requirements for running SLIM SHOW 1.0, or running projects produced by it are:

* IBM PC or compatible computer with sound card and mouse.
* 4 MB of free hard disk space.
* Microsoft Windows 3.1 or higher.    

 
SLIM SHOW 1.0 generates complete, standalone executable files that are ready to be played 
on target PCs, without the needs of many other supporting devices or files that may be 
required by other presentation programs.    The tiny multimedia engine and minimal system 
requirements make it easy for general PC users to enjoy professional multimedia 
presentations without the need for expensive equipment.    This is even more important if 
you intend to distribute your projects to your friends or customers because not all of them 
have a 200MHz Pentium PC with a 2Gb Hard drive!    And maybe they are reluctant to install 
a lots of files to their machines - even if they are free!

SLIM SHOW 1.0 can be used for many applications such as presentations, advertising, 
computer-based training, education, multimedia greeting cards, games and so on.    Because
of the small size, you can now pack professional looking work onto 3 1/2 diskettes or attach 
it in your E-mail for distribution.



Features:
___________________________________________________________

* Interactive Multimedia presentation platform for Windows 3.1 or higher.
* Eighteen built-in animation styles for graphics, together with the combinations of blanking 
out and resizing.    Other visual effects can be produced by arranging scenes externally.
* Various styles for showing text strings or text files.
* MIDI and WAVE audio playback.
* Built-in text-to-speech synthesizer.    Speaks any text. Pitch and speed adjustable.    Allows 
use of custom dictionaries.
* Text or graphical buttons for users interaction.
* Visual authoring environment allowing you to drag-and-place nodes. Properties of the last 
editing node in each object type are memorized automatically for easy editing of new nodes.
* Basic editing tools - Copy, Paste, Delete, Undo and Undelete.
* Creates standalone, ready to run projects with player.    Data compression provided for 
project materials.    Fully automatic load and play process.    All files are cleaned up after the 
show.    Tiny player footprint (50Kb non text-to-speech, 550Kb with text-to-speech).
* Creates executable file and collects resources to be used in other Windows programs.
* Show window can adjust automatically to target video size or set to a fixed resolution.
* Transporting of TrueType text fonts (TTF) for use on target machines.



The "mouse button" means the left button on your mouse (for right-handed users) or the 
right button for left-handed users.    This is the only mouse button you will be using in SLIM 
SHOW 1.0.



To "click on an object" means to point your mouse cursor at an object and press and quickly 
release the mouse button, without moving your mouse in between.



To "drag an object" means to point your mouse cursor at an object and then press and hold 
down the mouse button and move your mouse together with the grabbed object.



Getting Started
____________________________________________________________

Follow normal Windows procedures to start SLIM SHOW 1.0.    This will launch a main window
with a menu bar at the top, a graphic bar on the left, a scroll bar on the right and the 
working area in the center.    The menu bar is for executing commands, the graphic bar 
contains object icons, which are the building blocks for the multimedia project, and the scroll
bar is for scrolling the working area.    A recycle bin, for showing and recovering deleted data,
is located at the bottom left corner of the main window.    The central working area shows a 
diagram of the currently opened project.    This diagram consists of nodes linked by arrows 
which show the sequence of execution.    Each node is represented by an object icon that 
indicates the object type together with its node ID number on the left and annotations on 
the right.    ID numbers are assigned to nodes automatically and provide references for 
branch locations.    Annotations show file names, text and other important node properties.

Start creating your project by clicking or dragging icons from the graphic bar and placing 
them onto the working area.    New icons become nodes as they are placed and arrows 
appear automatically in between nodes to indicate the sequence of the show.    Nodes inside 
the working area can also be grabbed and moved.    

To change the properties of a node, click on its icon to open the property editing dialog and 
then edit the details.    For a node of "MIDI Music", "WAVE Sound" or "Speech" type, the 
"Play" or "Speak" button in the dialog window lets you hear the sound.    For a node of 
"Background", "Graphics", "Text", or "Button" type, the "View" button in the dialog window 
allows you to view a scene in a pop up window that looks the same as the show (target) 
window.    

The size of the show window can be set to either full screen    (automatically adjusted) or a 
fixed size.    A detailed discussion on this subject can be found in the "Deciding the show 
window size" section.

Click on or near the ID number of a node to select (highlight) that node.    To select more 
than one node, point the mouse cursor to the ID number of the starting node and drag the 
mouse to the ID number of the last node in the series and release it.    To select a large 
number of nodes, use the "Mark" command from the "Edit" menu to open a dialog box and 
type in the starting and ending ID numbers manually.    

Use "Copy", "Cut", "Paste", or "Delete" from the "Edit" menu to cut and paste or delete the 
selected nodes.    Use "Undo" to reverse your last change.

Deleted nodes go to the recycle bin.    You can undelete them by grabbing them back from 
the recycle bin.      All deleted nodes can be recovered from the recycle bin in reverse order 
of deletion.

Test run your work at anytime by choosing "Run" or "Run From" in the "File" menu.    "Run" 
will let you start a complete run of your project from the beginning (node #1).    "Run From" 
lets you run from any node (specified by the highlighted node) to save time.    Running will 
stop immediately after the execution reaches the "END" mark.    When the "END" mark is 
reached, all unfinished sounds will be stopped and aborted.    A show can also be interrupted 
by hitting the <Esc> key.

If the show window size you choose is smaller than the size of the screen you are currently 
using, the show window will appear on the screen with a title bar.    When a test run is in 
progress, the title bar shows the current scene(node) ID number, providing a debugging tool 



for tracing your project. 

When running a show, the main window of the SLIM SHOW program will be disabled.    You 
are still allowed to have other Windows applications running simultaneously, and even to 
change the input focus to other applications.    However, it is not recommended that you 
take the input focus away from SLIM SHOW when a show is running as the content of the 
screen may be corrupted when you do this.    Because the visual effect of the presentation 
relies on dynamically showing graphics on the screen, bitmaps and text images will not be 
repainted when the show window is brought back from the background.

From the "File" menu, use "Open", "Save" and "Save As" to load or save projects.    Once a 
project is finished and tested, use "Make Disk" to produce project diskette(s).    You can use 
auto mode to create diskettes that are ready to play in the target machine or use the 
manual mode to create a player and collect all supporting and other project material files.

The shareware version of the SLIM SHOW 1.0 only allows you to save projects with 25 or less
scenes.



Commands
___________________________________________________________

File Menu    Contains commands to open, save, run, make projects, and to exit.    
Edit Menu    Contains commands to mark, cut, paste, delete nodes, and to undo changes.
Option Menu    Contains the "Show window size" command for changing show window size.
Information Menu    Contains commands for getting Help, About and Order information.



File Menu
___________________________________________________________

File Menu contains commands to open or save projects, run projects, make disks or to exit 
the program.

The project files created by the SLIM SHOW 1.0 are binary files, with ".ss" file name 
extensions by default.    When a modified project is saved under an existing name, the 
original file is saved automatically to the same name with a ".ssb" extension as backup.    
Only one project is allowed in the work area at once.

New    To start a new project from scratch.

Open    To load an existing project to the work area for editing, running or making.    

Save    To save the currently opened project.

Save As    To save the currently opened project to a specific name.

Run    To run the opened project, starting from the beginning (Node #1).

Run From    To run the opened project from the highlighted node or the first of more than 
one highlighted node.

Make Disk    To Make diskettes for distribution, or collect files and generate the player and 
supporting files for use in other Windows programs.    The "Make Disk" command invokes the
"Make SHOW DISK" dialog window for specifying the Make options and proceeding with disk 
making.

Exit    To exit the program.



Edit Menu
___________________________________________________________

Edit Menu Contains commands to mark, cut and paste nodes, to delete nodes, and to undo 
changes.

Cut    To cut the highlighted node or nodes from the work area and put them onto the 
Clipboard.

Copy    To copy the highlighted node or nodes onto the Clipboard.    The contents of the 
working area are not affected.

Paste    To retrieve the node or nodes from the Clipboard and paste them at the position 
before the highlighted node or nodes.

Delete    To delete the highlighted node or nodes and move them to the recycle bin.

Undo    To undo your last edit - i.e. the last action to alter the structure of a link or the 
contents of a node.

Mark    To highlight a node or nodes by manually giving the starting and ending node ID 
numbers.



Option Menu
___________________________________________________________

Option Menu contains the "Show window size" command for changing show window size.

The "Show window size" command invokes a dialog box for selecting the size of the show 
window which determines the window size that will be used in the final presentation.      The 
show window size can be set either to a fixed dimension or to the full screen - this changes 
automatically to fit target machines.

The show window size can be changed easily during the project editing phase.    When you 
prepare a project for distribution, this information will be built into it.    If you want to change 
the show window size after a project is built, you must run "Make Disk" again.

Although changing the show screen size is trivial, it is advisable that you decide on the size 
as early as possible in your project design phase since changing the show window size may 
affect your graphics layouts (Text and Graphics objects).    Please refer to the "Deciding the 
show window size" section for a more detailed discussion.



Information Menu
___________________________________________________________

Information Menu contains commands for getting Help, About and Order information.

Help To bring up the on line help document.
About To display copyright and contact information
Order To display order information 



Building a Show Project
___________________________________________________________

SLIM SHOW 1.0 provides an authoring environment for you to easily create your multimedia 
projects.    Your project can show text and graphics on the screen, play MIDI music and WAVE 
sounds together with synthesized speech via your audio device.    It also contains buttons 
which allow your audience to interact with your presentation.

The recommended procedures for building a project are:

1. Deciding the show window size.
2. Preparing materials.
3. Creating the project file.
4. Testing the project.
5. Making the project for distribution (not needed if you are running your project using 
the SLIM SHOW program directly).



Deciding the show window size
___________________________________________________________

The first thing you should do in designing a project is to decide the size of your show 
window.    Although this value is easy to change from the SLIM SHOW program, you should 
determine it as early as possible because:

(1) you need this information when creating your bitmap files as well as selecting your text 
fonts, and 
(2) it may have a significant impact on your project if you change this at a later stage as all 
of the graphical scenes may be affected.

You have two choices for the show window size, the fixed size method and the auto-adjusted
method.    The fixed size method always displays your project in a window of fixed X-Y 
dimensions specified by number of points.    If the target machine's screen is larger than this 
dimension, the show will be displayed in a small window with a title bar at the top.    If the 
target machine's screen is smaller, your show will be clipped and only the center part of it 
will be seen.    To guarantee that your show will not get clipped in different target machines, 
you will need to design your show to fit the lowest possible size, which is usually 640 by 480 
by today's standard.

If you choose the auto-adjusted method, it will always adjust the show window size to match
the full screen size of the target machine.    However, there are two concerns if you take this 
approach.    The first is that the bitmap graphic files are stored by fixed size and if you map 
them directly without resizing, they may leave blank spaces or get clipped on different 
machines.    Using the "resize" option you can avoid this by letting the image stretch to fit to 
the specified location.    However, because of the resizing, your graphic may be a little 
distorted.    The second concern is that the size of the text is always determined by its font 
and is not scaleable.    Although the text still gets shown at the designated place,    the 
relative size of the text to the target screen will vary.

Please note that the above discussion assumes that you are going to show your project on 
many different machines.    If your project is only to be shown on a dedicated machine with a
known display size then this will not be an issue.



Preparing Materials
___________________________________________________________

To create a project, you will have to prepare all your presentation materials.    Graphics 
should be standard Windows bitmap files.    Text objects use either literal string or ASCII text 
files.    You will also need to prepare text font files if you plan to use special fonts that are not
installed in your system.    For sound, you need Windows WAVE or MIDI files.    For speech, 
use literal strings.    Buttons use either literal strings or bitmap files.

Once you have all these materials ready, you can use SLIM SHOW 1.0 program to build your 
project.



Creating the Project File
___________________________________________________________

A show project is made by placing and linking nodes and assigning properties to those nodes
in the working area.    A node is the basic building block of your show and is 
described by its object type and other properties.    

There is a total of ten object types in the SLIM SHOW 1.0 for showing scenes, playing audio 
and controls.    The ten object types are: Background, Graphics, Text, WAVE sound, MIDI 
music, Speech, Sound Control, Timer, Go To, and Button.    

The properties of nodes contain information such as filenames of the materials, animation 
styles, audio volume, branch positions, and so on.    Nodes are linked together by arrows, 
which determines the execution flow of the project.

Each node in the project has a unique ID number.    These ID numbers are assigned 
sequentially from one to the maximum number of nodes allowed (32,000) as new nodes are 
added to the project.    Normally the execution starts from node #1 and    follows the ID 
sequence unless there is a branch node.    Two object types effect a branch - the "Go To" and 
the "Button".      When a "Go To" node is encountered, the execution sequence of the show is 
unconditionally changed to the node that it points to.    Branches can also happen at button 
nodes.    They occur when the button is pressed and more than one button can appear at a 
time for users to make a selection.

As nodes get moved, deleted or inserted, the ID numbers will be reassigned automatically.    
For "Go to" or "Button" nodes, the destination properties that specify their branch locations 
will also be adjusted accordingly.



Object Types and Properties
___________________________________________________________

There is a total of ten object types in the SLIM SHOW 1.0 for building the project.

Background
Graphics
Text
WAVE Sound
MIDI Music
Speech
Sound Control
Timer
Go To
Button



Background

Background objects specify the color to be used for painting the background.    You can 
specify the color by clicking on the "Color Select" button, which opens a color selection 
dialog window.    From the dialog window you can choose any one from the forty-eight colors 
in the "basic color" template, or define and pick your own color.
    
To define custom colors, press the "Define Custom Colors" button and bring up the color 
definition template.    Move the cursor inside the color refiner box and drag the arrow beside 
the luminosity bar to define your color.    You can also create a color by typing numbers in the
Red, Green, and Blue boxes, or the Hue, Sat (saturation), and Lum (luminosity) boxes.    Click 
the up and down arrows to change    the numbers.    After the color is picked, you can add it 
to any one of the sixteen user defined color boxes and assign that color to be used for your 
background.    

When a Background node is executed, the whole background can be repainted immediately 
or left unpainted.    This property is specified by checking the "Repaint now" check box.    In 
either case, the new assigned background color will affect the followed bitmap and text 
scenes.



Graphics

Graphic objects show bitmap files on the screen.    You need to specify the full name of the 
bitmap file to its "File" property.    The maximum number of characters allowed for the file 
name is 80.      You can either type the name directly in the Edit box or click on the "File 
Select" button to open the file selection dialog window and make the selection.      

You can choose from one of the eighteen built-in styles by using the "Style" combo box to 
show your graphic file.    Together with styles, there are three other properties to select.    The
"Resize" property lets you choose to display the bitmap either in its original size or to have it
stretched within a rectangular dimension.    To show a bitmap as its original size, the 
specified display position will only be used as a reference to calculate the alignment, while 
the actual size of the picture is determined by the bitmap itself.    The bitmap will not be 
clipped to fit to the display region if that region is not big enough.    The "Left Align" property 
lets you choose to align a non-stretched bitmap either by the upper left corner or by its 
center point relative to the display region that you specify.    The alignment property will be 
ignored if you choose to resize the bitmap because the stretched image will always fit the 
specified display area.    Instead of showing a bitmap, the "Blank" property let you clear the 
bitmap with the background color.    The 18 show styles also affect blanking.

The position property of the graphic is specified by the four numbers that describe its left, 
top, right and bottom positions.    The numbers used to specify the position are in a scale of 
zero to ten, allowing two decimal places.    The number sets the position relative to the 
dimension of the show screen.    0.00 means the left or top most position on the show 
screen, 5.00 is in the middle and 10.00 represents the right or bottom corner position.

A position custom control is used to specify the display area of the bitmap.    It has one big 
rectangle on the outside that represents your show window screen, and a smaller rectangle 
in black located inside, representing your bitmap.    You can move the black rectangle by 
dragging it inside the larger rectangle.    You can also change its size by moving your cursor 
close to the rectangle boundary and dragging it, in the same way you change the size of a 
regular window.    The four boxes attached to the right of the control give the exact values of 
the left, top, right, bottom positions of the bitmap.    When you change the position or size of 
the small rectangle by dragging it, the contents inside these four boxes will be updated 
automatically.      You may also enter numbers directly into these boxes to change the size 
and position.    When you do this, the inside rectangle of the custom control will change 
accordingly.    

The wait time property specifies the period to wait (snooze) before the execution of the next 
node.    A delay value between 0 and 32 seconds is allowed, with an accuracy to 0.1 second.  
If you want to snooze more than 32 seconds, you need to add timer nodes.



Text

A text object shows text on the screen.    Either a literal string or a text file can be used, 
which is specified in the "Text or File" property.    For literal text, you enclose the string inside 
two quotation marks (") and type it into the Edit Box.    For a text file, you can either type in 
the whole name of the file into the Edit box, or use the "File Name" button to open a File 
selection dialog.    Note that if you do not use the two quotation marks to enclose the text, 
the text will be used as a filename.    The maximum number of characters you can put in the 
"Text or File" property is 80.    

You can specify three option properties for the text object.    Normally, when none of the 
option boxes are checked, the text will show up immediately when the node is executed.    
Each character will be shown with the rectangular area around it painted with the 
background color.    All text is aligned at the center of the specified display area, both 
horizontally and vertically.

The "Marching" option makes the text to appear one character at a time instead of all at 
once.    The "Transparent" option lets you paint the text only and leave the surrounding area 
untouched.    The "Align left" option forces the text display to start at the left top corner of 
the area that you specify.    Note that the alignment is meaningful only if all of the text can 
be fitted into one line of display.    If not, then the text will always be displayed from the 
upper left corner and will change the row automatically when the right boundary is reached. 
If space runs out before the whole text is displayed, the rest of it will not be seen.    

For text files, they should contain only printable ASCII characters and the CR-LF(carriage 
return/line feed) control characters.    The maximum number of characters allowed in a text 
file is 4096. 

A text object is not scaleable.    Its size is determined by the text itself and the text fonts 
used.    The display area you specify is used as a reference for alignment, and if there is 
insufficient space, the text will be clipped.

The position of a text object is specified in the same way    as the Graphics object.

The wait time property specifies the period to wait (snooze) before execution of the next 
node.

Text can be displayed using any text font installed on your system.    For presenting on target
machines, the SLIM SHOW program bundles all the special TrueType text fonts that you used 
to the project.      If the font you specify is not available on the target machine and it's not 
TrueType, the player program will find a suitable replacement to use.

Please be aware of the license agreements for the special text fonts - you may not have 
rights to distribute for use in other machines.    Always make sure you have sufficient rights 
for all of the materials you intend to distribute.      SLIM SHOW 1.0 will show you a list of all 
the material files that it is collecting when building the project disk.



WAVE Sound

A WAVE Sound object plays a Windows WAVE file via the audio device.    The full name of the 
WAVE file needs to be specified in the "File" property, and the maximum number of 
characters you can use is 80.    Depending on the length of the WAVE sound, the playback 
may take a while to complete.    The "Wait for complete" option lets you decide if your show 
should move on while the WAVE sound is playing.    If you have this option checked then the 
execution of the following nodes must wait until the WAVE playing is finished, otherwise 
execution will continue while the file is playing.    The WAVE playing can only be overlapped 
with nodes that do not need the Windows wave output device.    Two object types need the 
wave device, the WAVE Sound and the Speech.    When execution reaches a node of either 
one of these types and if the wave output device is still busy with the previous playback, 
then you have two choices - either abort the previous playback, or wait for it to finish.    
Please be aware that if you choose the latter then the whole presentation must wait.    This 
option is specified by checking the "Interruptible" box.    When the box is checked, the 
successor node that needs the wave device can abort the playback of this node.    WAVE 
playing can happen at the same time as MIDI playback, because they use different audio 
resources.    

The volume slider is used to set the volume of the wave output device.



MIDI Music

MIDI Music objects play MIDI files.    The way to specify their properties is the same as for 
WAVE Sound Objects.



Speech

Speech objects produce synthesized speech from text.    You specify the literal string that you
would like to be spoken in the "Text" property - the maximum number of characters allowed 
is 80.    Please note that the two quotation marks are not needed in a Speech Object.    If you 
include quotation marks, they will literally be converted to the string "quote" and spoken 
out.    

The "Wait for Complete", "Interruptible" options and the Volume properties are the same as 
for the WAVE Sound object.    The "Tempo" slider adjusts the speed of the speech, and the 
"Pitch" slider adjusts the tone.    

You can customize the pronunciation of words by editing the dictionary file used by the 
synthesizer.      You can also use a different voice font file for different speech sounds.    For 
more information on the speech synthesizer, please refer to the "The Speech Engine" 
section.



Sound Control

Use Sound Control objects to adjust the volume of, or stop, MIDI and WAVE audio.



Timer

A timer object provides a delay period within the show.    The delay time can range from 0.1 
to 32 seconds.      It is used to add wait times in the presentation.      For example, you might 
need to play a MIDI tune for ten seconds before showing a picture, or turning down its 
volume, etc.    You may link more than one timer together to extend the delay time beyond 
32 seconds.



Go To

A "Go To" object forces a branch in execution.    The node pointed to by its target property 
will become the next node for execution.



Button

A Button object provides a way for users (audience) to interact with your presentations.    It 
forces the node pointed to by its target("Go to") property to be the next one for execution 
when pressed by the user.      For each button node, if its successor (the node underneath it, 
not the node pointed by its target property) is also a button then it will spawn a thread to 
this next node automatically in the execution.    Because of this, if more than one button is 
connected in sequence, they will all be shown on the screen at once.    The execution will 
wait indefinitely at the last node of a series of button nodes for users to take action.    Once 
the user presses any one of these buttons, all the buttons disappear and execution 
continues from the node pointed to by the pressed button.    

You can draw text or a bitmap on a button by specifying the literal text or the filename in the
"Text or File" property.    When specifying a literal string, you need to enclose it in quotation 
marks.    You can use up to 80 characters.    

The size and position of the button are specified by the "Position" control, and should be 
assigned in the same way as for the Graphics object.    

A button can be shown with or without its outline - this is defined by its "Draw Outline" 
property.    The "Resize" property of a graphic button allows the bitmap to be stretched to fit 
on the button.    If you do not check this option, the bitmap will be shown in its original 
dimensions.      It will be clipped if the button size is too small, and blank areas will be added 
if the button is too large.    Unlike the Graphics object, the size of a graphic button is always 
drawn to the size that you specify.    

The mouse cursor changes to a hand shape when it is moved over a button.



Editing Techniques
___________________________________________________________

Adding a new node
Deleting a node or nodes
Undeleting a node or nodes
Moving a node or nodes
Selecting a node or nodes
Marking a node or nodes
Copying a node or nodes
Cutting a node or nodes
Pasting a node or nodes
Undoing the last move
Editing node properties
Using memorized properties



Adding a new node

Clicking on an object icon in the graphic bar will append a new node of that type to the end 
of your project.      If you want the new node to be placed between your existing nodes 
instead of at the end, you should drag it from the graphic bar and release it at the 
appropriate point.    Always use the tip of the arrow-shaped mouse cursor as the reference 
point for releasing objects.



Deleting a node or nodes

You can drag a node and release it to the recycle bin to delete it.    You may also delete one 
or more nodes by selecting (highlighting) them first, then pressing the <Del> key on your 
keyboard.    Using the "Delete" command from the "Edit" menu works the same as pressing 
the <Del> key.



Undeleting a node or nodes

You can drag nodes back from the recycle bin and put to any place you want in your working
area.    The recycle bin works like a stack, saving all your deleted items.    You recover deleted
items from the recycle bin in the reverse order to which they were deleted.    The recycle bin 
also remembers how many nodes you deleted each time, and keeps them the same when 
you recover them.    For example, if you delete three nodes at once, when you undelete you 
will be grabbing three nodes back, connected in their original sequence.    The recycle bin is 
cleared when you save or open projects.

You can return a recovered item to a different place from which it was deleted.    This 
provides you another method of moving nodes around, and is especially useful when you 
want to move more than one node at a time, or if you are moving some distance from its 
original place.

You can also use the "Undo" from the "Edit" menu to recover your deleted nodes.    This way, 
the deleted nodes will always be returned to their original locations.    However, you can only
undo the last modification.



Moving a node or nodes

You can move a node from one place to another simply by grabbing the node and dropping it
at the desired location.    It you need to move more than one node at a time, or move 
something to a place outside the current screen, you can delete them to the recycle bin and 
then restore them back to the desired place.    Use of the Clipboard also achieves this.



Selecting a node or nodes

A node or nodes must be selected before they can be deleted, cut or copied.    Also, selection
provides a reference for the "paste" and the "Run From" commands.    In the SLIM SHOW    
program, at least one node will be selected at any time (highlight will be on the "END" 
marker if the project contains no nodes).    When a node is not selected, its ID number is 
shown in black on a white background.    A selected node or nodes have their node ID 
number shown in reverse color.    We will also refer the selected notes as "highlighted".      

Clicking near the ID number area of a node will select it.    To select more than one, point the 
mouse near the first node's ID number and drag it to the area near the last node's ID.      If 
you need to highlight more nodes than can be shown on one screen, use the "Mark" 
command in the "Edit" menu.



Marking a node or nodes

Use the "Mark" command from the "Edit" menu to select one or a sequence of nodes by 
giving the ID numbers of the first and the last nodes.    A simple dialog box will appear for 
you to type in the numbers.



Copying a node or nodes

Use the "Copy" command from the "Edit" menu to copy the selected nodes to the Windows 
Clipboard.    The Clipboard is a global storage area managed by the Windows system for 
applications to exchange data.    Data copied to the Clipboard from SLIM SHOW can be used 
later for pasting.    This provides a way for moving or duplicating nodes.    You can also use 
the Clipboard to import and export nodes between different project files.

The maximum number of nodes that can be copied to the Clipboard at one time is 500.    

The Copy command can also be given by pressing <Ctrl><c>.



Cutting a node or nodes

"Cut" is the same as "Copy" except that the selected node or nodes will be removed from 
the working area.    A "Cut" command can also be given by pressing <Ctrl><x>.



Pasting a node or nodes

"Paste" from the "Edit" menu is used to paste data from the Clipboard.    Nodes on the 
Clipboard will be inserted before the current highlight positions.    If you want the data to be 
pasted at the end of the project, put the highlight on the "END" sign.

Data on the Clipboard will not be destroyed by the paste operation.    The "Paste" command 
can also be given by pressing <Ctrl><v>.



Undoing the last move

"Undo" from the "Edit" menu provides a way for users to back out from their last 
modification to the project data.    This includes changes in a node's properties or the way 
nodes are linked.      A modification can be caused by "Add", "Delete", "Move", "Cut", "Paste" 
or by invoking of the dialog that changes the properties of a node.
    
The "Copy" command, or the changing of highlight positions or screen size will not modify 
the project data.

One limitation of the "undo" command is that you cannot undo an "Undelete".    Another 
point to note is that when "OK" is    pressed in the Property editing dialog, even if you did not 
really making any change to the properties, it is still considered to have been modified.    
However, if you press the "Cancel" button to back out the dialog, then this does not    count 
as a modification.    

The "Undo" command can also be given by pressing <Ctrl><z>.



Editing node properties

Click on the node icon to change the properties of that node.    A Property Editing dialog box 
will pop up for you to make changes.    The title of the dialog box tells you the node's ID 
number and type.      

For MIDI, WAVE or Speech nodes, a "Play" or "Speak" button can be pressed to listen to the 
sound.    The "Play" or "Speak" button will change to a "Stop" button after the sound starts so
that you can stop the playing anytime.      For text, bitmap or button type nodes, a "View" 
button can be pressed for previewing.      When pressed, a preview window that is the same 
as the target window will pop up showing the scene.    Depending on your current display 
size and the show window size of your choice, the preview    window may be a smaller 
window appearing in the center on your current screen, or it can occupy your whole screen.   
If your current display is smaller than the show window size then you will only see the center
of the show.    Unlike sound playback, the "View" button will not change to a "stop" (for 
returning to the property editing dialog).    This is because the button may not be accessible 
if the view window covers your whole screen.    To clear the view, you can either press the 
<Esc> key on your keyboard or click on any place in the view window (except on top of a 
button).    If the view window is smaller than the whole screen, you can also go back by 
clicking on other places in the editing dialog window.    Do not click on the "View" button 
because this will show you the view again.    

Once the editing is done, press the "OK" button to accept the changes.    If you decide not to 
make changes, press the "Cancel" button.



Using Memorized properties

For each object type, the properties of the last edited node are saved automatically as 
default values for further new nodes of that type.    This is very useful when you are creating 
a series of nodes that have similar properties.

The node's properties only get memorized when you hit the "OK" button in the last editing.



Testing the project
___________________________________________________________

Test run your work at anytime by choosing "Run" or "Run From" in the "File" menu.    "Run" 
will let you start a complete run of your project from the beginning (node #1).    "Run From" 
lets you run from any node (specified by the highlighted node) to save time.

Running will stop immediately after the execution reaches the "END" mark.    When the 
"END" mark is reached, all unfinished sounds will be stopped and aborted.    A show can also 
be interrupted by hitting the <Esc> key.

If the show window size you choose is smaller than the size of the screen you are currently 
using, the show window will appear on the screen with a title bar.    When a test run is in 
progress, the title bar shows the current scene(node) ID number, providing a debugging tool 
for tracing your project. 

When running a show, the main window of the SLIM SHOW    program will be disabled.    You 
are still allowed to have other Windows applications running simultaneously, and even to 
change the input focus to other applications.    However, it is not recommended that you 
take the input focus away from the SLIM SHOW when a show is running as the content of the
screen may be corrupted when you do this.    Because the visual effect of the presentation 
relies on dynamically showing graphics on the screen, bitmaps and text images will not be 
repainted when the show window is brought back from the background.



Making the project for distribution

Once your work is finished and tested, you can use the "Make Disk" to pack the project file, 
material files and SLIM SHOW player and make the whole thing into a standalone, ready to 
run package for distribution.    This allows your audience to run your work without the SLIM 
SHOW program.

You have two choices when building your projects.    In automatic mode, your project will be 
built into a package that contains one executable file and one or more compressed data 
files, ready to run on the target machines.    All that your audience need to do is insert the 
first diskette in the machine and run the executable file ("show.exe") from within Windows.    
The executable will read all the packed data files, prompt users for changing diskettes (if 
more than one is needed), decompress and present your project.    Once the presentation is 
complete, all resources will be removed from the target machine automatically.    In this 
mode, you usually specify the destination drive to be a floppy drive (A: or B:), although a 
hard disk subdirectory is also allowed.    You must specify the size of the diskette so the data 
can be packed and cut to files that can fit.    The "Make" dialog window will prompt you to 
insert and change diskettes.

The auto mode builder creates compressed data files to diskettes.    The data file on diskette 
#1 is named "ss1.dat", on diskette #2 is named "ss2.dat", and so on.    On the first diskette 
there is also a file named "show.exe", which is the loader program.    This is the program to 
run from the target machine.    When executed it will read and expand files, call the player 
program for running the show, and clean up all the files after the show.

The other way to build your work is to use the Manual mode (to collect files only).    Instead 
of building everything into a ready-to-run package, the manual mode builder generates a 
player executable file with supporting libraries, and collects your project file and material 
files and saves everything to the destination that you specify.    Usually the destination 
should be a subdirectory on your hard drive, unless you are sure that they can be fitted onto
one floppy diskette (diskette changing is not allowed in this mode) and you do not mind if it 
is slow.    This mode is useful for Windows program developers that wish to integrate the 
SLIM SHOW player into their applications.    The SLIM SHOW    player program ("ssplayer.exe")
is a Windows executable file and there are many ways for you to run it from your application,
for example by using the "WinExec()" or "LoadModule()" API functions.    To have the player 
run properly, you will need to place all of related files, which include the project file 
("show.ss"), the speech-support files (the voice font file and dictionary file), and all the 
project materials (WAV, BMP, MID, TXT) into the same directory as the player file.    You can 
place the support libraries (the DLL files) in that directory too or you can place them in the 
Windows system directory.    If there are special text font files, you need to either install them
or to add the resources before executing the player.    If the project does not have Speech 
nodes then the speech library, voice font, and the dictionary will not be included.

In either one of the two Make file options, the program will show you a list of all the material 
files that will be packed.    The material file includes all the bitmap, MIDI,    WAVE, text files 
and any special text font files that need to be used in the project.    One very important thing
to do is to check this list and make sure that you have appropriate rights for distributing 
these materials.



Make SHOW DISK dialog window
___________________________________________________________

Destination drive/directory    To specify the full path (drive:path) of the making 
destination.

Option    To specify whether to build the project in auto mode or manual mode (creating and 
collecting files only).

Diskette Size    To specify the diskette size used in the auto mode.

Project Title    To specify the Project Title.    A string up to thirty-two characters is allowed.    
The Project Title will appear in the title bar of the show window (if show window is smaller 
than the screen) during show time.



The Speech Engine
___________________________________________________________

The Speech Engine used in SLIM SHOW 1.0 is a real text-to-speech synthesizer that can 
generate speech from any randomly provided text.    It is not a digitized voice playback 
system nor a pre-recorded word catenation system.    The speech engine generates speech 
by translating text into phonemes using its internal rules.    Sometimes these rules do no 
pronounce words properly, so an exception dictionary which maps words into their desired 
pronunciations, is used to override the rules.

The speech engine and voice font takes about 500K bytes of disk space.    This equals about 
45 seconds of voice recording using 11.025 KHz/mono sampling rates.    A general guideline 
is that if you are recording voice for more than 45 seconds in your project, the speech 
synthesizer will save you disk space over digitized voice.    When building your project    files, 
the SLIM SHOW program will check to see if the project contains any speech object.    If no 
speech object exists then it will not build the speech engine files into the project.

The speech quality of the synthesized speech is not as good as digitized human voice.    
However, there are advantages to using the speech synthesizer other than just saving disk 
space.    For instance, you do not need to record the voice, making changes is easier and it 
allows you to change the tempo and pitch.

You can use different voice font files to get different voices, but only one voice font is 
allowed per project.    You can customize your pronunciation of words by editing the 
dictionary.      The dictionary editor program comes with the diskettes for registered users.    
You can also download the editor from PC WholeWare's Web site.    It is included in the 
freeware(demo) version of the WinSpeech 3.0 and Clip&Talk 2.0 programs.

The Speech Engine comes with the SLIM SHOW program is to be used within the SLIM SHOW
player only!    You are not allowed to use it for other purposes.



Order, Licensing, Distribution, and Others
___________________________________________________________

The program you are now using is a shareware.    You may install it once on your PC and use 
it for (at most) 30 days for evaluation.      It is strictly forbidden that you use this shareware 
program either after the 30-day period, or for purposes other than evaluation.    You may not 
distribute your projects made by this shareware version.

If you would like to use this program, you need a registered copy from PC WholeWare, MA, 
USA.      There are two different licensing plans of registered versions:

Standard version.    $49.95 (Tax/shipping/handling included).    You may use one copy of the
SLIM SHOW program on one computer at a time, to make presentations directly or to make 
projects for distribution.    For each project you make, you may not distribute more than 20 
copies - otherwise it will be considered enterprise use.

Enterprise version.    $99.95 (Tax/shipping/handling included).    You may use one copy of 
the SLIM SHOW program on one computer at a time, to make presentations directly or to 
make projects for distribution.    You may build your projects and distribute an unlimited 
number of copies provided you do not sell them for profit.    For example, you could build a 
training project and distribute to employees, or make a product promotion project and send 
it to prospects.    

If you intend to distribute a product with the SLIM SHOW's player built inside for profit (e.g. make a story book and 
sell it), you need to obtain a commercial distribution license from PC WholeWare.      For each product, the cost for a 
royalty-free commercial license is only $49.95.    Please contact PC WholeWare for a sample copy of the distribution 
license agreement before ordering.

To order SLIM SHOW 1.0, please fill out or prepare the information on the order form and use
one of these methods:

(1) Send a check or postal money order (the currency must be in US dollars) paid to PC 
WholeWare, and mail it with your order form to:

        PC WholeWare
        33 Justin Street,
        Lexington, MA 02173
        USA

(2) Order by phone, fax, mail, or directly from the Internet by using a credit card 
(VISA/MC/AMEX/Discover).    This is an ordering service provided by PsL.    The reference 
number for the SLIM SHOW program in PsL is #14987.
    
By Phone: 800-242-4775 or 713-524-6394 (7AM-8PM CST Monday-Thursday, 7AM-12:30PM 
Friday)
By Fax:      713-524-6398
By Mail:    PsL, P.O.Box 35705, Houston, TX 77235-5705, USA
By Internet: go to "http://users.aol.com/wholeware" and follow the instructions.

(3) From CompuServe.    Type "GO SWREG" from CompuServe and follow the instructions.    



The Registration IDs for them are:

SLIM SHOW (Standard version)    -    #13823
SLIM SHOW (Enterprise version) - #13829

Your order will be shipped to you by first class mail as soon as it is received.

(Please have the following information ready, or use it as the order form for fax/mail order)

Name _______________________________________________________________________
                                                                                                            
Address _____________________________________________________________________

City _______________________    State _____    Zip code _____________ Country ___________

Phone Number ____________________________ E-mail ______________________________

SLIM SHOW (Standard Version) Quantity ___    X    $49.95    =    _______________

SLIM SHOW (Enterprise Version) Quantity ___    X    $99.95    =    _______________

Total:            ________________

Credit Card Information:

Type of card:                  VISA _________      MC _________    Amex _________    Discover _________

Card Number ______________________________________    Exp. date ________________

Signature _________________________________________________________________



Contact information
___________________________________________________________

Postal Address:

PC WholeWare
33 Justin Street
Lexington, MA 02173
U.S.A.

Telephone:

617-863-2546

Web URL:

http://users.aol.com/WholeWare/index.html

E-mail:

wholeware@aol.com
103671.2141@compuserve.com




